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Integrate BeyondTrust Privilege Management for Mac with
BeyondInsight

Overview

Privilege Management combines privilege management and application control technology in a single lightweight agent. This
scalable solution allows global organizations to eliminate admin rights across the entire business. With the integration between
BeyondInsight and Privilege Management, you have a proven privilege management solution that transmits data about your
endpoints and policies to a centralized management console with the reporting and analytics capabilities needed to effectively

operate your business in a secure fashion.

Network Considerations

An event service is used to communicate between PM and BeyondInsight using port 443. Events from PM
TCP Port 443 are sent to BeyondInsight using this service. Communications over this channel is secured by means of a
client certificate.

Prerequisites

« BeyondInsight version 6.9.0.712 or later
« Privilege Management for Mac 5.4.51.0 or later

x Note: The reporting component is available in BeyondInsight versions 6.10 and later.

L]
1 For information on integrating BeyondTrust Privilege Management for Windows with BeyondInsight, please see the
Privilege Management for Windows Integration Guide, at www.beyondtrust.com/docs/privilege-

management/windows.htm.
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Steps to Integrate Privilege Management for Mac with
BeyondInsight

Once you have BeyondInsight and Endpoint Privilege Management installed in your environment, you will need to configure both
instances to communicate with each other. Below is a list of high level steps needed to complete the integration.

« Create and deploy the Beyondinsight client certificate to all potential Privilege Management for Mac endpoints or policy editor
machines.

« Using Mobile Device Management (MDM) or your method of choice, deploy the Privilege Management for Mac client and
BeyondInsight adapter on all endpoints.

« Configure the settings_app.xml file on the endpoints with the BeyondInsight Server information.

« Verify Beyondlnsight is receiving heartbeats and information from Privilege Management for Mac endpoints.
« Configure the policy editor to communicate with BeyondInsight and test the connection.

« Create a new policy in the editor.

« Create a Smart Rule in BeyondInsight.

« Assign and deploy a policy from BeyondInsight.
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Installation Information for BeyondIlnsight and Privilege
Management for Mac

Prior to integration, verify all BeyondInsight and Privilege Management components are properly installed in your environment.

|/-_-‘."|
(1) imPORTANT!

To complete this integration, please make sure you have the necessary software installed and configured as indicated in this
guide, as well as any network considerations.

Beyondlinsight Installation

i For detailed instructions on installing BeyondInsight in your environment, please see the BeyondInsight Installation Guide
at https://www.beyondtrust.com/docs/beyondinsight-password-safe/bi/index.htm.

Privilege Management for Mac Installation

7 Fordetailed instructions on installing Privilege Management for Mac, please see the Mac Administration Guide at
hitps://www.beyondtrust.com/docs/privilege-management/mac/index.htm.
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Create and Deploy the Beyondinsight Client for Privilege

Management for Mac

To establish communication between BeyondInsight and Privilege Management for Mac clients, a client certificate must be generated
from BeyondiInsight, and then installed on every Privilege Management for Mac client needing to transmit information to

BeyondiInsight.

Generate Client Certificate ZIP

1. On the BeyondInsight Server, go to C:\Program Files (x86)\eEye Digital Security\Retina CS.

2. Run REMEMConfig.exe, which opens the Beyondinsight Configuration Tool.

3. Click on the Certificate Management link.

BeyondInsight

4 Administration
Emai Address
Administrator Usemame
Administrator password
Authentication
Use Secure LDAP Connection
Centtral Policy
Virtual Directory
Central Policy Password
Central Policy Machine URI
CSWebgate Web Site Information
CSWebgate Vitual Directory
CSWebgate Access URL
Authentication Logout URL
Database Information
Sever
Database
Command Timeout
Connection Timeout

bi@example.com

Administrator

False

PolicyService

NN-2K12R2B

RetinaCSWebgate

http:/#nn-2k 2r2bi/RetinaCSWebgate
lacal)

RetinaCSDatabase

300

300

Test Connection

Create Datsbase
Uparade Database
Manage License

Install SSL Certfiicate
Disable Debug Logging
Stop Services

Start Services

Sync Benchmarks
Disable Light Writebacks
Generste Cenfficate msi
Generate Certificate Zip
Import Cedificates

Grant Permissions

Client Authertication: Enabled

Authentication Type Windows
Encrypt Connection False

ManagementConsole:Enabled
Event Service: Enabled
Password Safe Ul: Enabled
Confiqure HSM Credertials

Email Address
SMTP emal address to use for reply address and for sending administration emails

G

4. In the Certificate Management dialog window, select Export
Certificate.

(O Generate cetficate
|@Emmnerﬂicae |

Certificate type: | Cliert cedfiicate v

Select Client Certificate as the Certificate type.

Enter a chosen Password. We recommend that you use the

existing BeyondInsight Central Policy password. Passwod  [— ]
7. Click the ellipses (...) to browse to your desired location. ::mp e B v oee yaEnelert ] [ =

« Enter a File name and select Certificate files (*.pfx) as
the Save as type. We recommend that you name the
certificate eEyeEmscClient.pfx.

« Click Save.
« Verify the Path has been filled in correctly.

8. Click OK. A notification appears, stating The Client certificate has been exported. Click OK again.

Install the Beyondinsight Client Certificate on the Endpoint

You may use the deployment method of your choice to get the client certificate to your endpoints, whether that be Mobile Device
Management methods (such as Jamf or AirWatch), manual configuration, download from a shared resource, etc.

1. On the endpoint, locate and double-click the eEyeEmsClient.pfx file.
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2. In the Add Certificates dialog box, make sure that System is ® Add Certificates
selected in the Keychain field.
. E Do you want to add the certificate(s) from the file
3. Click Add. “eEyeEmsClient.pfx" to a keychain?
Keychain: System B

View Certificates cancel  [ETHE

4. Enterthe admin username and password to authorize the
change, and click Modify Keychain.

~~ Keychain Access is trying to modify the
system keychain.

u Entar your password to allow this.

User Name: Admini

Password: || |

Cancel Modify Keychain

5. Inthe next window, enter the certificate password and click OK.

= Enter the password for “eEyeEmsClient.pfx":

H Password: | | |

cancel  ([CTSNN

6. The new certificate will appear in the Category section. Choose [sse 0 as
one and double-click the certificate. This step also adds a private o com.appie kerberas ks

@ Local ltems. Expires: Saturday, December 26, 2037 at 6:28:03 PM Central Standard Time

key to the Keys category. & S
[ System Roots
= A EEe )
» ) com.apple kerberos kdc certificate Dec 26, 2037 at 6:29:03... System
(] com.apple. kerberos.kdc certificate Dec 26,2037 at 6:29:03... System
|-|] eEyeEmsClient certificate Dee 17, 2028 at 10:21:19... syguml
==
A Atrams
/.. Passwords
Secure Notes
& My Certificates
1 Keys
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7. Inthe certificate window, expand the Trust section and choose ene eEyeEmsClient
Always Tru.st from the When using this certificate field. Then - e
Close the WlndOW. ertifente | |esiued by: eEyeEmsCA
== - Expires: Sunday, December 17, 2028 at 10:21:19 AM Central Standard Time
& "eEyeEmsCA" certificate is not trusted
¥ Trust
When using this certificate ¥ Use System Defaults I ?
N |
Secure Mail (S/MIME) — novawe specmea d
| Extensible Authentication (EAP) no value specified
: IP Security (IPsec) no value specified
| Code Signing no value specified [
| Time Stamping no value specified
X.509 Basic Policy no value specified
¥ Details
Subject Name
Name lignt
Issuer Name
i C Name A
8. Inthe Keys window, double-click the private key. [ese 10 a
B Vi — ‘com.apple kerberos.kde
© login \ Kind: public key, RSA, 2,048-bit
W' Local tems F Usage: Encrypt, erty, Wrap
et 13
[ System Roots
u..,'. R & o s e B
i com.apple.kerberos.kdc public key - - System
e T B N =
e a— B T
Category
A Allltems
A.. Passwords

Secure Notes
[ My Certificates
9 Keys
[ certificates

9. Selectthe Access Control tab in the private key window.
10. Select Allow all applications to access this item and click Save Changes.

Install the Privilege Management for Mac Client

The client and the adapter are obtained from BeyondTrust after purchasing Privilege Management with BeyondInsight, and may be
distributed to the endpoints using the method of your choice, including Mobile Device Management (MDM), such as Jamf or
AirWatch.

The filenames are as follows, where x.x.x.x represents the version:

« PrivilegeManagementForMac_x.x.x.x.pkg
« BlAdapter_x.x.x.x.pkg

To install the Privilege Management for Mac client:

1. Double-click the PrivilegeManagementForMac_x.x.x.x.pkg file.
2. Click Continue on the Introduction page.
3. On the Software License Agreement page, click Continue and then click Agree to agree to the terms and conditions.
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4. (Optional) To change the installation destination, click the Change Install Location button. The Destination Select page will
allow you to choose from viable installation location options. Click Continue.

5. Click the Install button on the Installation Type page. If prompted, () @ Install Privilege Management for Mac 5.4 a
enter your admin credentials to continue. Click OK if the Standard Install on “0S10.14
Installer.app needs permission to modify passwords, networking,
or system settings.

Introduction This will take 118.4 MB of space on your computer.

o
» License Click Install to perform a standard installation of this software
» Destination Select on the disk "0510.14".
L

Installation Type

®

BeyondTrust Change Install Location...
Privilege Management

Go Back Install
6. The Summary page shows that the installation was successful. (@0 @ Install Privilege Management for Mac 5.4.34.0 &
Click Close to complete the installation. The was s
» Introduction
» License
» Destination Select
o Installation Type
» Installation

The installation was successful.

& Summa
= The software was installed.

BeyondTrust
Privilege Management

Install the Beyondinsight Adapter

You may use the deployment method of your choice to get the BeyondInsight adapter to your endpoints, whether that be Mobile
Device Management methods (such as Jamf or AirWatch), manual configuration, download from a shared resource, etc.

1. Double-click the BlAdapter_x.x.x.x.pkg file.
2. Click Continue on the Introduction page.
3. On the Software License Agreement page, click Continue and then click Agree to agree to the terms and conditions.
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4. Click the Install button on the Installation Type page. If prompted, |@® ‘@ Install BeyondTrust Bl Adapter a
enter your admin credentials to continue. Click OK if Installer.app Standard Install on "0S10.14"
negds permission to modify passwords, networking, or system R T —
Sem ngs' » License Click Install to perform a standard installation of this software
o Destination Select for all users of this computer. All users of this computer will
be able to use this software.
e Installation Type
BeyondTrust
Privilege Management
Go Back Install
5. The Summary page shows that the installation was successful. )  Install BeyondTrust Bl Adapter a
Click Close to complete the installation. The was
» Introduction
» License
» Destination Select
» Installation Type
» netaliauan The installation was successful.
® Summary
The software was installed.
BeyondTrust
Privilege Management
Edit the Settings File
Once the BeyondInsight adapter is installed, modify the settings file, <2xml version="1.0" standalone="true"?>
located at ILibrarylAppIication (Se-tzt;:g:;\ldentlﬁer>- SERAE P RO SR AR W0 BB < /InstallTdentifier>
Support/BeyondTrust/Defendpoint/settings_app.xml, to include the e o DS o A R SR, </umauelD>

CSServer>https:/ /L% Bk L L & 51 /EventService/Service.svc</RCSServer:
CSCertName>eEyeEmsClient</RCSCertName>
<RCSWorkgroupName>BeyondTrust Workgroup</RCSWorkgroupName>

server URI and certificate name as follows:

<RCSServer>example.com</RCSServer>
<RCSCertName>eEyeEmsClient</RCSCertName>

Note: The adapter, when installed, creates the settings_app.xml file with some default values pre-populated. Only the
RCSServer field is empty, to be configured by the user.

Check to See if the Endpoint has Connected

After the settings file has been configured, the Privilege Management endpoint is capable of checking into BeyondInsight and
sending events to Beyondinsight. If you have access to the machine running the BeyondInsight Server, you can determine if the
endpoint has checked in by using either of the following methods:

1. The endpointis visible on the Assets page, at Assets > Endpoint Privilege Management.
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x Note: Configure the Activity Monitor to show all processes, as BIAdapter runs as user _defendpoint.

2. Run the following SQL query:

select * from Asset PBDInfo
select * from Asset PBDInfoEx

wbi <?xml version="1.0"?>
T’p: IfyOU Want tO f(?rce &l pOI’Cy update fOf a Cllentgeﬂ:lng an i <Se§;2:§;\ldennﬁer>li-nu. B AT EF WA €A B e W 8</Installldentifier>
update for the first time, you can restart the BeyondInsight e s o J R MR BRI < {uniguelD>
ersion>5.4.0</Version>
ivii i y
adapter. In the Activity Monitor, restart the BIAdapter process. RS eEl s byeEmsCliont</RCSCortiames

<RCSWorkgroupName>BeyondTrust Workgroup</RCSWorkgroupName>

The default time for the policy update and for the heartbeat is Heartbeathecaived>0</HeartbeatRacalved > =~

six hours. These values can be changed on the Beyondinsight
Server, and the policy can be applied to the endpoint, but this STy vandatonitervalVariance>
policy would not be applied until the initial 6 hour period has
elapsed. Manually changing the RCSHeartbeatinterval and
RCSPolicyValidationinterval values in the settings file will also
cause the endpoint to check in more often. Enter the values in
minutes.

</ Settlngs>

If you have access to the endpoints, you can use either of the following methods to determine if they have checked in:

« Open Console and filter on subsystem: com.beyondtrust.BIAdapter. Ensure that Info and Debug Messages are on. Logs
about the connection will be displayed in real time. You can check when the next policy validation is scheduled, as well as the
next heartbeat request.

« Open Activity Monitor. The BIAdapter service is displayed as running.
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Configure the Privilege Management Policy Editor

After you deploy the client certificate to your Privilege Management Policy Editor machines, you can set up the Privilege Management
Policy Editor and configure the editor to work with BeyondInsight.

1. Launch the Microsoft Management Console (mmc.exe) as an admin and go to File > Fie| Action View Favortes Window Help
Add/Remove Snap-in. New CarleN
Open... Ctrl+0
Save Ctrl+§
Save As..
| Add/Remove Snap-in... CtrieM |
Options...

1 DFP Mgt Censole.msc

2 CAWINDOWS\...\services.msc

3 Certs.msc

4 CAWINDOWS\...\compmgmt.msc

Exit

2. Inthe Available snap-ins menu, locate and select the Privilege Add or Remove Snapins
Management Settings (Beyondinsight) snap-in. You can selec snap-n for ths conscle from those avalable on your camputer and confgure the selecied setof napns. For

extensble snap-ns, you can configure which extensions are enabled.

3. Click Add >, then click OK. The Privilege Management Settings REsitoTxE e e

Snap-n ~ [ console Root Edit Extensions....

(Beyondinsight) snap-in will appear in the Console Root menu. 3 rviege Menzgement Resarting .

i Privilege Management Settings
[ Privilege Management Settings (BeyondIn:
Move Down

X

¢ Privilege Management Settings (PMC)

=] Resultant Set of Policy

1 Security Configuration and Analysis

5 Security Templates

i services

5] Shared Folders

(D Task Scheduler

i TPM Management

ngdows Defender Firenall it Advancec |,

Add =

Advanced. ..

< >

Desaription:
This snapin allows you to edit Priviiege Management Settings online using Beyondinsight

= ==

Test the Connection
Before continuing on with the remainder of the integration setup, you need to test the following:

« Testto ensure that a client certificate of the correct name is available in the certificate store.
« Testto ensure the policy editor can reach the BeyondIinsight Server.
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Actions
To test, click on Remote Server Details from the Welcome page. From Welcome  Tools [ iese Maragerent
the Beyondinsight Server Details dialog, enter the server details. Then e — M‘"“‘"""‘X
click Test by Certificate Name and Beyondinsight Server to check
each component. Gonnection
Certificate Name [eeyeemsciient J| et |
. eyondinsight Server hitps://i Test
Note: The Certificate Name and Workgroup Name fields are e b L=
populated Wlth default Values. Workgroup Name [BeyondTrust workgroup |
If a certificate of the correct name is found, a message appears stating [ ot o e ]

Valid certificate found in certificate store.

If the BeyondInsight Server can be reached, a message appears stating

The server was reached successfully S _Ca |
The server was reached successfully. | [t ]

When finished testing, click Save.
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Create a New Policy in the Privilege Management Policy Editor

Once you have established communication between the Privilege Management Policy Editor and the BeyondInsight Server, you can
create a new policy from the editor.

1. From the Welcome page, click New Policy.

Welcome  Tools

Learn More
Learn more about Endpoint Privilege Management

Learn more about Beyondinsight

A, Beyondinsight Policy
.o No Beyondinsight pelicy open
Browse all Beyondinsight policies
. Beyondinsight Account
“ ‘administrator’ is signed in
Sign out

2. Enterthe credentials used to log into your BeyondInsight

& Beyondinsight Sign In *
instance.

Username |administrator |

Password |~rmm1 |

Forgot Password | Signln | ‘ Cancel ‘

3. Type in a name for your new policy, and then click OK. Palicy Name %

Name for your policy

| Tesﬂ |

I oK || Cancel |

The Welcome page will update to show more options, including: Welcome  Tools

Learn More
Learn more about Endpeint Privilege Management
Learn more about Beyondinsight

l Licensing
Valid license

a Challenge / Response
e Set Challenge / Response Shared Key

« Export Policy
« Import Policy
« Import Template
« Digitally Sign

« Save Report
« Challenge/Response
Beyondinsight Policy

.\ Youre editing Test'

Upload changes

« Beyondinsight Policy
« Beyondinsight Account
BeyondlInsight Account

“ ‘administrator’ is signed in
Sign out
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1 For more information on policy creation and best practices, please see the Privilege Management for Mac Admin Guide at

https://www.beyondtrust.com/docs/privilege-management/mac/index.htm.

Upload Changes

Once you have created and modified your policy, you can upload your
changes to BeyondInsight by clicking Upload Changes on the Welcome
page.

@

Go & N [T

Welcome  Tools

Learn More

Learn more about Endpoint Privilege Management
Learn more about Beyondinsight

Licensing
Valid license

Challenge / Response
Set Challenge / Response Shared Key

Beyondinsight Policy
Youre editing Test
Upload changes
BeyondInsight Account

‘administrator’ is signed in
Sign out

After you have uploaded your policy to the BeyondInsight Server, you can view it in BeyondInsight Server from Menu > Configuration

> Privilege Management Policies.
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Create a Smart Rule and Assign Policy in Beyondinsight

After you have added and uploaded your policy to BeyondInsight from the policy editor, log into your BeyondInsight instance to create
Smart Rules and assign policies for assets and users.

. Tip: If Beyondinsight and Privilege Management for Mac are successfully communicating, the Endpoint Privilege
- Management option becomes available under Menu > Assets.

Create a Smart Rule for Assets

1. In your Beyondinsight instance, click on Assets.

Beyondinsight )
[

ot iy o | oot

2. Click Manage Smart Rules.
3. Click New.

From the Smart Rules Manager for Assets dialog, type a name
for your Smart Rule.

Check Active.
From the Category dropdown, select Assets and Devices.

Beyondinsight e
[T

Enter a description, if needed.

© N o o

In the Asset Selection Criteria section, design a query to pull in
the assets you wish to assign policy to.

Tip: For this example, we can narrow down the results of our query to locate our test system, NN-1K12RBR. Choose
Match ALL Criteria. Select Asset fields > Asset Name > contains > NN-1K12RBR.

9. From the Perform Actions dropdown, select Deploy Endpoint Privilege Management Policy.
10. Click the .. button.
11. Selectan option from the policy you uploaded from Privilege Management for Mac .
12. Click Save.

7 Formore information about creating and organizing Smart Rules, please see Use Smart Rules to Organize Assets in the
BeyondiInsight User Guide at https://www.beyondtrust.com/docs/beyondinsight-password-safe/bi/index.htm.
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Create a Smart Rule for Users

1.
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9.
10.
11.
12.
13.
14.
15.
16.

In your BeyondInsight instance, click on Policies.
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Click Manage Smart Rules.
Click New.

From the Smart Rules Manager for Assets dialog, type a name
for your Smart Rule.

Check Active.
From the Category dropdown, select Policy Users.

Beyondinsight | ...

Enter a description, if needed.

In the Selection Criteria section, design a query to pull in the
users you wish to assign policy to.

Click the .. button to build your query.

When finished, click Save.

From the dropdown, choose the query.
Check Discover Users.

From the Perform Actions section, choose your policy users and policies you wish to apply. Order policies as needed.
Select Show as Group.

Click OK.

Click Save.

1

For more information about managing policies for EPM, please see Manage User Policies in the BeyondInsight User
Guide at hitps://www.beyondtrust.com/docs/beyondinsight-password-safe/bi/index.htm.

Grant Users Permissions to Log into the Policy Editor

If you

would like to grant additional users access to log into the Policy Editor, read and write access needs to be included on the

Privilege Management for Mac assets. This access is included by including permissions in the Smart Rule.

1. On the BeyondInsight Home page, click Configuration.
2. On the Configuration grid, select Role Based Access > User Management.
3. Locate the group you wish to edit and click the vertical ellipsis button to the far right.
4. Select View Group Details.
5. In the Group Details pane, click Smart Groups.
6. Inthe Smart Groups Permissions pane, select the appropriate Smart Group.
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Beyondinsight | Configuration o
E] BeyondTrust User Management ~ Group: local\Demo
GROUP: LOCAL\DEMO < ¢

Has 6 users
@ Active (last synced on Oct 02, 2019, 2:41 PM)

Group Details < Smart Groups Permissions @

sron
Details & Attributes Enabled SmartGroups  + W Filter by -

Features (43)

Smart Groups (43)

43 items (1 selected)

Users (6) (®) smart Group Name Organization

(O Anassers Asset Global Full control o H
API Registrations

() il Managed Accoums T:;grid Global Full control 0
Managed
(3 Al Managed Systems P Global Full control 0
Endpoint Privilege Management Clients Asset Global Full control o E] I

7. Click either the vertical ellipsis button to the far right or the Assign Permissions button at the top of the list.

8. Click Assign Permissions Full Control.
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Install and Configure Privilege Management Reporting

For assistance installing and configuring Privilege Management Reporting with BeyondInsight, please contact your BeyondTrust
representative.
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